277E6

www.philips.com/welcome
TH aqfiasly 1
AMsQUARNAT LazAsFulsyAu 30

nsunlalym &
AN NNLUAL 36

PHILIPS


www.philips.com/welcome

fNsiiey

1.

1. 1 fupautiamnulaande uaznis
1139501 ... e ——— 1

1.2 ma%vmwmmfsawmumoq ...... 2

1.3 msiandadaun uasisqussaiuna

QRCT AL Tk T — |

2.1 MIARON o 4

2.2 MITAWIUIDAN e PR 6

2.3 uwuzin MHL (AvalaiaWifiduiiada)
8

2.4 vayaiiasaumalulad SoftBlue 9

ASUSLATWIRATNHR evrerreesens 10

3.1 Smartlmage Lite.......ccccveirrnnns 10
3.2 SmartContrast .........cccevvuiiines 11
3.3 Philips SmartControl Lite ......... 11

AAYAFUNILAIUNATA .oereenne 18
4.1 anuazdan & Trnuawsida ...... 20

ANTAANTITWAIV I cererrermnnennn 21
>~ P o P Y o o
AayatnaAusTidauAalivau . 22

N5uagnAl wazn1s5uilszAiu30

7.1 wlgwneadmduRniaaniiauad
AaawLLuLUuRaY Philips....... 30

7.2 mMsquagnal & nssulsedu..... 32

. . 4
n1sunlaidaui & draunwuuag
36

8.1 MIUATUTYW T oo 36
8.2 A ufnuuang uaas SmartControl

Lite..vevenens PP e 37
8.3 drauAnuuaag M'l............. 38

8.4 MHL FAQ....ccccuiiiiiiiiiiiiieee, 41



1. dfiey

pflagludidnnsafinadifilhdmsunnauila
aanw Philips 1naaugiianludinauiiay
Lsulmamywammanauﬂsunanmﬂpaga
Afey uazuadunan1vg LAeAuAs Y
A@DANUAIANL

ms¥udseAuas Philips fitnAundasauni
finsiansasnatvangangInsun1slaun
fanraaddudunaunisldounasndasan
wagifiadiiuaaineiagiansunisaanway
maoLLamoInawawsainLasasmaumuaun
ﬁaumss"mumﬁa ﬁamtmuammu u,a“su
syfsnunaaunsnanuandafan

1.1 dueauiiamudaania way
A151N595nN

(A Adiau .

asladmauan Msliuune wianszny
nslag Muanmilaannssylutanansaliy
1 avadunaluiAalwvhdas duesieann
Assud WY wag/viaduanamenaanle

a‘mua%aummmumaummu “Luﬂum”‘m
LﬁaumaLLa”‘Lmamwﬂauwumaswa\mm

AN51119U o

« lUbsaduranmwlu i o nuFIUaalALAs
URIE W T ALY NFY WAZW NN
Lma MRl AAINT aud u MU N
& NIP[oR au‘luam:rm 7 uWfunanuana
vinlu i eaanwla ‘wud wasdaANu
W amela

. mma’tm w awmnaovl,ﬂ’tussvmumnm
nfail aonumsmmmm uamamm“
sguaanany us T LEnnsalna uav
DNN

o agfad ugszinsamAuudIAs av

© 0l 2NEUUUIAMNATIARTU LU 1A
sansaw 199ld” Aawnas uaue udeau
18 aa199aane

. nv'1:1"vi"ln'lsa.fmamwimﬂmmammu
(2151 mwmas wiaaalW DC, 58 6
TUTn aurt azaaasnaLALT anas
wsaze'lW DC &msunisvineudae

« Tsaly sevi e sunssusasd’
Philips W~ MAIBALIAT A wmu"l,V\Imao
Al Tusad an adudus” usns
Tudszimauasaa (Tisag, Aus U aNRE,
uf Taawi ansauaaNA 1)

o ag i [amwitmss ugewiaunsala su
ANTNTTUNAYT TUUTITEWD 19NV

¢ aHAIE VUS 2R WrA UW U 19
ANTVINIIUNS 2NNTUUR 9

51595 NEN

« ui a1 avAulamwuavnaRINANNLE &
Wi anaw e “ule asla us9nan an
4] Tulduuny 1aa LCD ‘Lu‘um"m AR au
] maamwmamm‘tu Fun AsauLd aan
agl wnaapww‘tmumsawu ansail 129
AuUKU 13a LCD

- oamld” naanw a 1aaazluly [anw
ufuszagnaiunu

« aaald” mamwa aarulua aoviA
graalas a\m mw 2l nfmnumm Al
mmmmf m*viu waam RN Tuzoie
Wil aes av ay 10”Lsnmu ael 1”L°u AV
azamd ung o i uaanaaaal “sa
IRV MNALaNTuule W arinanu
gzananANUAIAL

. Lﬁlaua“ma"mmmwf'uamn"l,wwv'm“am
0S| amwm"umnm'gsm a6i2LAT By ann
W AW WA ‘uN uuu T usagnw
Wea auvt sfanue winnuFull

.« a wamwv.umﬂmuf anln wfmm W N 9
eI g asvinla

. ad sulandaauns’ au 1 Mlluranw
29AU Tsaifawas’ agviuvl uavnan
& nmu”l,waanmnu uum’ouﬂanﬂaau
wfau Maan waza aad avludedqus ns
11599 NN

«aswfundaly aaawluaauni o v
U@ nANNT au uavaTae 1nansy
W5 AT IAMNWLET UG

ol ashmaNsTaurMIYINU 6 |6
wavIANINWUBIAM UaT Al U
W emunud u Tusaly aaawludgaund
‘n"an aamnTuazaNY uag Mnaluu
w suu“h



. amwnal: 0-40°C 32-95°F
«  anud u: 20-80% RH

« &dny: ufaviouldsunsuans uav
nai’v‘l”ﬁmsmva“ aulmiaua Ll ana
daagaaawit 9h 'ir,)u"Ln 1o T 9u
wfavinuualwa e us wsauu 13a
ufusmzj L&A 0 AN NUBIAMAL
ugaoul amt L'ifu_mwﬁ‘ vaf luans
Wl gunidas Msludndemznsuany
Wil o il ae aud aanfuszﬂmajuju
anavinin Lf‘w’mn'ﬁ"pj“s‘u;fu"wf'av‘l’ 3 4N
Auluains "mwa " usa "Mwinge "
UUUU 1RDUDIA

« a3 "ufs ua Tu", "AWA n'" wia "M
Tnan " ufuﬂiwn;]msm W dnAue lu
mm’iu‘iau nu 1=1a LCD mumnua 2
ans L‘1.Ii ugu" wia mwn W' usa
"wlnae " auﬂ auq wieldu anawu
14l wdgannit faas ag

(A Adiau )

as ludavinouaniuiaiias wiaualwa
mifu’%w\lsﬂumaa}ﬂuswm matﬂuwa’m
tina1ns "aalun” wia "nwane” wsa
mw‘Inam amoiuu,sa ﬁoa”"lumﬂ"m Uay
"Lummin-llammm"lm ANuLEafinan
mmunu"Lu"LmumwﬂumaomU‘messu
Uszuravnal

usn15

« Wfases asmsif alaa 1us s
Taaugule w1 u

o o ufanuafus adly Lananslag
gusunmsa auuai TUsad ae afue
us nstudlssmazagaas (Tsaaun
"due U ayAK, us1na")

o & wsua auald endunsaua e ilsee,
W a "y axaIUNILe uwmaIla"

«  aul gamwuasaalhy Tusasua /v Tase
ul aaaaut 9 nRvUAA

=) RULILUG

Bnsnamafiau3nis arranw'luvineu
dlulnd vidaaalauulanaaseiu
ﬂ‘iumums‘lm‘lummmﬂaummumumaum‘lu
Mluafiaatut

1.2 AladuuuasiAzasuiung
M99

muﬂaﬂma"Lﬂuaﬁmﬂmmamnaomaa
wwiagninaaeg Alaluanssatiuil

UNTEIUA VAAITIEIY UarALGian

aaanqiiaauil anafiaruzasuaniiud
uamwsaunuiaﬂau LLRy‘WﬁJ‘Wﬂ’JEIG\’JMu’]
vwiadday SHuzaszamuwmanil da
WUNEILG 2aA55239 v3aAdau dolade
aalud:

=) UL
lamaufl szudetayasdny uazmafiafiang
°luﬂm°£°1.ﬁ“nuﬂaummasmaoﬂm"lmmu

(1) 1aMI5759 . ) .
lanauilszyfivuayanuaninaandniasy
‘IamaﬁamﬁmmmLﬁwmmam‘smn% wia
nMsgadavaya

(A ddiau . .
lanauilszyfiviananasiinduesiana
T9NE LaguanIgnIsudnidavilgyn
mLmaumaamamaﬂswng’lusmmnmLusm
A9 LAY ma"LmJmmam"l,aﬂau"bmmnu
unseidanad mmammmamawumaﬂ
mﬂlmmsmuﬂuimwummuaanmunuma
WoduAmuad



1.3 AMSNINAAAUN UALIG
ussyivuvia

alnsallivuazdidansatindidauan-
WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation in national take-back initiatives
and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and related
packaging material) in accordance with all
Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page


http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
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DVI
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Main menu Sub menu
— Input — VGA
— Dvi

— MHL-HDMI (available for selective models)

— Picture — Picture Format — Wide Screen, 4:3
[— Brightness — 0~100
— Contrast — 0~100
— SmartResponse — Off, Fast, Faster, Fastest
+— SmartContrast — On, Off
— Gamma — 18,20,22,24,26
{— Pixel Orbiting — On, Off
(available for selective models)
— Over Scan — On, Off
L (available for selective models)
— Audio — Volume — 0~100
(available for selective models)
— Mute — On, Off
— Stand-Alone — On, Off
— Audio Source — On, Off
(available for selective models)
L Color — Color Temperature ~— 500K, 9300K
— sRGB
—— User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English, Deutsch, Espafiol, EN\nvikr, Frangais,
Italiano, Maryar, Nederlands, Portugués,
Portugués do Brazil, Polski, Pycckuii Svenska,
Suoml Tiirkge, Cestina, VKpa’l’chKa,fﬁW[ﬁi.
ey, BAH, ol
— OSD Settings — Horizontal — 0~100
— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time Out — 55, 10s, 20s, 30s, 60s
— Setup — Auto
— H.Position — 0~100
[— V.Position — 0~100
— Phase — 0~100
[— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes,No
L— Information
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alnsalfinwsandumaTuladangaly
ARTARNATU LNaNTUTsINANALREAT
AaLAUAINTIAG Aanawlsilalanay
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B asdade

ﬂ.f]ﬁﬁ@lwvfumau wasvinmsindaln
quysal
aaigansailatdsunsulandvainiinig
ARAIRNYI
maanasnsidaldsunsuluaanas
AMEINIAARATIVIVAALULARANaL
wiauaumaviia'le

PHILIPS

www.phillps.comiwelcome

Monitor driver and software installation

Philps SmartControl

usnge e -Wizard (6227a8519)

luafousnudsannnisineo
SmartControl Lite tp3avaziila Wizard
(fznaasy) duiniaada TuliGa iy
nsiatdsunsuasousn
fmeaTvazuusinnauAmAunslsy
ANALANRNTTOULUDIADATWLDIAMUT
azdunau

aawsnsaluy Plug-in (wdndu)
Lﬁmflmﬁamuasw‘lumwa"avmL‘Jjuﬁu
ﬂmmmsaﬂsummanmaﬂ LG
Taalunaslafmaasrolaalanuing
Standard (u165571)



B smartcontrol 2%
SmartControl Lite PHILIPS

Wizard

You'l need to calbrate your dsply to get the most

tuning process by selecting t
tune your dsplay and sa ttin
\ 1. Choose the Start Wizard button
2. Follow the steps outined i this process.
0 3. Save your settings for future use

Adjust Audio
\g Auto prot
-
Coor oo
o L
2
Options Presets
\ Muti Monttors
Help

Start Waard

H @ususauiuneie Standard
(uassu):

iy Adjust (U3u): 3

iy Adjust (U5u) aygnaluaaliu
Brightness (a31u&319), Contrast (Aa
unsan), Focus (TWAR), Position
(6u1Aug) wag Resolution (Au
avLdam)

. acummsnvhmui”mmau wazvinnslsu
M

« Cancel (anién) azannlanAMAaIN1s

HALANNTHAAYYSA TN

W smartcontol 2%

SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wil result i 3 loss of

detai in darker image areas. Adjust the Brightness for

le picture qualty.

he Brightness to the minmum level
Adiust the Brightness as needed to achieve
an equal separation of the stripes.

Brightness

ad

Contrast

Color oY
3
EEEE Brightness 100

- +

€

Postion

Options 4

Resolution

undo Reset

&

Help
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SmartControl Lite

Adjust
Brightness
Contrast.
Color A
3
4 Focus
o
Postion
Options.
"
ii Resolution
Help

8 smartcontol

SmartControl Lite

Adjust
srghiness
Contrast
Color an
. Focus”

P

\E Poston

optons

®

4

Help

8 smartcontol

SmartControl Lite

]

Adiust
Brightness
\g Contrast
Cobor A
ool
% Fous
\@ Postion
Options o
Resolution

®

Help

@y

PHILIPS

Contrast

Contrast (use the sider) to keep detais in

ntrast untd the numbers 1 and 2

1 visble.
Contrast to make the
reappear. The number 1
i barely visble

Contrast. 50

undo Reset

@x
PHILIPS

Focus
Your display’s timing needs to be synchronized with
the vdeo signal

1. Choose Auto Setup.
Tt al bands are stil vble, you'l need

ands disappear.
Phase: Adjust to the brightest settng to minmae
movement on the screen.

e %
ase v
= &
unto At sep
@x

PHILIPS

Position

ns to center the image on
thi tool, you can postbon the image
aht.

Up/Down buttons to center

2. Use t/Right buttons to center the image
horgontaly

Undo Reset




W smartcontol

SmartControl Lite

Adiust
Brghtness
\5 Contrast
Color ~a
A
. Focus
.
poston
Options ﬁ
Resolton
tiep

wuy Color (&): 3
iy Color (&) auanelnaailsy RGB,
Black Level (s¢6iuds), White Point

(am&w), Color Calibration (n1515u

@

PHILIPS

Resolution

You are currently at a Preferred resolution. For your
disply to show crsp, clear text, Colors, and images,
vour display should be set to s Preferred resolution.
I your dspiay s at 2 Non-Preferred resolution, clck
on the Preferred button to change your resolution to

I™ Enable Resolution Notfier

Picture Format
I™ 43 aspect ratio

ﬂmmmsavhmm‘]”umau wagvinnsdsu

AT ATURN s”\hﬁ%/ﬂiﬁﬂﬂ'\ﬂuuﬂaﬂ

faenva&mu Color Calibration (A3

Wisud) way Smartimage Lite
a
audefinaulauiantal
Usuiieud)

CEmm

SmartControl Lite

]

Adust e
Back Level
Whte Pont

Display Gamrma

"E» gﬁ

-l
Options. Calbration
ap

Smartimage

®

Help

@x
PHILIPS

Black Level

Impropery adjusted Black Level wil result in 3 loss of
etai n darker image areas. Adjust the Black Level for
the best possble picture quaity.
1. Adjust the black level of the Red, Green, and
Bue usng the sider bars.

Red s0
o L/
Green 50
= O &)
Ble 50
= &

undo Reset
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SmartControl Lite

U "

Adiust RGB.
Whte Pont
Disply Gamma
L
Options Galbration
. ap
Smartimage
Help
W smartcontrol

SmartControl Lite

]

Adjust RGB
Color White Point
N "
Display Gamma

\
@p

®

Help

8 smartcontol

SmartControl Lite

1]

"

Adiust RGB.
Black Level
Whke Pont

Display Gamma
optons cabrston
ap

Smartimage

g4

®

Help

PHILIPS

White Point

ich equal combinations
ful ntensty create

acts the overal cobor quaity. For the
cobrs clck the Reset button then

e Pon.

i select the White Point value for the best
possble color qualty.

White Point & the pon

Wite Point 6500K
S (o} +

undo Reset

PHILIPS

Display Gamma

Gamma is 2 component of the pixel brightness in 3
disply. A lower Gama vakue produces brighter pixels
and a higher Gamima value produces darker pxeks. The
defauk value for Gamm & 2.

To adjust Gamma, Smartimage must be set to Off.
Clck the Smartimage Off button before adjusting
Gamma.

1. Use the sider to select the desred Gamma

Display Gamema 22

undo Reset

@

PHILIPS

Calibration

iy calibrated i order
f colors accuratly.

whenever you move your disply to a

1. Make al other necessary adjustments t
qualey fist.

2. Press Show Me to lear how to use the

calibration took.

Frialy, press Start to begn the calibration

¥ Enable color calbration

Color software designed n colaboration with Joseph
Holmes.

Protected by U.S. Patent No. 6,686,953

Show Me start

Quick View



1. "Show Me (u&nal1ig)" Bunssaauien
AunsUsuiiaud

2. Start (3u) - BGuassumslsuaud
6 2unay

3. Quick View (ga&n9i3?) Tanawnay/
HRY

4. unmsnduladfominaendn Color (&),
adniju Cancel (anian)

5. Enable color calibration (1avinouns
ﬂs”nmunﬁ) AmBGuaudadda an'lila
vinA3aguang umuﬂnmﬂuaumm‘m
vinmsdfuiaud du "Eu" uag "gasne
" aziluiinnang

5
6. paviizayadniinsluninaanisdiu
Wieu

uunaansUsufiaudusn:

« 1u Previous (naunun) gnflansvineu
AunsENeivnunadNaad

« 1w Next (da'ld) lldouhwnaaa’la (6
thwvune)

. ﬂunm"lﬂaﬂmua""lﬂﬂwmma
File>Presets (‘lWa>w3idin)

+  Cancel (ani@n) da UI uaznauluds
w1 Plug-in (wanau)

SmartImage Lite
aumm’(uw’tmﬂaﬂuu'ﬂaomsmom Lwa'm

PPy g

Vl(ﬂ msmmmmamNammmummuam

wladean Entertainment (Ayuiiuiia),
SmartContrast uay SmartResponse aziiln
YNy
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SmartImage

‘Smartimage provides dferent brightness and
day's o of

Chooss the setting that is most comfortable or
when viewing your appiication. Atemately

effci
simply choose the one that best descrbes s type.

i

"

Adiust RGB.
Black Level
Whe Pont

Display Gamma

!
ap

Smartimage

g gﬁ

Options

()
o ]

Internet

®

Help

Standard

Options>Preferences (étdan>n15
Anuadnaly) — agvitnuniziiialdan
Preferences (nMsiniundnzals) nnLuy
Options (#tdan) vulaugaInanlulasu
AsaduRuunsiauaiunsa DDC/CI, agl
W@wzwin Help (381a1) uaz Options (67
Ll&an) iy

1 Smartcontol 2

SmartControl Lite PHILIPS

Preferences

P

e,&ren(es

udo

]

Adjust

Auto Pivot

ﬁ‘

Color Tnput
Weard
2

¥
Presets

Muli Monttors

L3

Help

¢ uEAINITHIAMITAINUAR N HaLzTaR Y

. naaammmsawmﬂ unsidavineu
ama’mum naaammsammmﬂums
aausumwmsvm'lul,l,au”l,mmo'm

+ Enable Context Menu (1avineutuy
lawn) uumanmaﬂavanmmsammm
(fla) AuAGuau Enable Context
Menu (tdavinsrutuyiiiam) wagaans



t8anuav SmartControl Lite & usu
Select Preset (1@anw3tdia) uay Tune
Display (J5uaausdaina) Tuangiiam
indnauueannail Disabled (la
vineau) au SmartControl Lite anawuy
lavne&nan

+ ‘lamau Enable Task Tray (tdavinou
a1091u) gavinesasuang (a) enw
A5uaY Enable context menu (1
vinuylilam) ugasuyanaeu
d& w3y SmartControl Lite Asadnuni
lanauaauu BUIAIAILAANLUYATN
f& sy Help (351%), Technical Support
(Msaduauuaunatia), Check for
Update (asyasaumianian), About
(tAdy) way Exit (aan) ia Enable
task tray menu (tdavinvutuyana
szuu) gnilavinou lanauanaszuuay
wdgagLanig EXIT (aan) winilu

+ Run at Startup (summsumu) gnvin
wdagwing (1la) auaFuay ia
flavinvnu, SmartControl Lite (s
sanautnsa lan) aglndadudasy
au wiaagluainou ideiasida
SmartControl Lite Adaidaananedauu
wannal wiannlualdsuasummiy
wiLdalag j?‘n;’folmtfmffu&ﬁal,‘s‘gmu ag'ly
gntvian Wanaavillulaviniesasning
ag (davineu)

+ Enable transparency mode (1davinenu
Tiualsela) (Windows 8, 7, Vista,
XP) a1i3uauda Opaque (Auuavy) 0%

Options>Input (édan>aunn) - 3y
vinuawziiailian Input (3uwe) ann
tuy Options (¢&an) uulaudasnanlule
Funmsavusuunfiauauisa DDC/CI,
maww"u,mu HeIp (381%) uay Optlons (n
1dan) winifu wiiy SmartControl Lite Auq
Wonuaaglalule
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SmartControl Lite

Adiust

Color

>
Options

=
Help

X

PHILIPS

Input

IMPORTANT! If you s

Analog In Digtal In

. uamwmmwumau Source (uniae
fuana) waznsdemuviaddaana
auwmﬂaauu

° UUADUFAINR

uav'luwiu

ALAEN MHTG]WOHQU

Options>Audio (Grnaan>18u9) — g
vinulawzilaiian Audio (1&eav) ALy
Options (L8an) winifu
UuRaLEAINAT I laFuNsRTuRYUAfiAL

& usa DDC/CI, mmawuumu HeIp (38
12) wag Options (ft&an) wifu

W8 smartcontol

SmartControl Lite

Adijust

Color

PHILIPS

Audio




Help>User Manual (35121>afias1al) -
agviouaniialdan User Manual (mJa
w“lﬂ) iy Help (38120) uulauanonad
"Lu”l,m'sumsaunauumummajmsn DDC/
CI, asfiiawrzuiiu Help (38141) uaz Options
(adan) Nty
B SmartControl o

SmartControl Lite PHILIPS

User Manual

Adjust

User Manual

{ ®
Color p

\£~

\ =3

Options

N

@

-1
Help

User Manual Tech. Support

HeIp>VerS|on (';ﬁ‘tq.l>na's’iiu) - Y
vinnutangiatdan Version (nasﬂ’u) N
iy Help (3ﬁ‘£°u) tuRauEAINAT ATy
msauuauumumwagmsa DDC/CI, azfi
W@wzwin Help (381a1) uaz Options (62
Ll&an) iy

8 smartcontrol @x

SmartControl Lite PHILIPS

Version

ol
0 EVALUATION dtune-pp-R2009-12-17-

Adjust

User Manual

= 2
usdate

Color a
3 Dy

.

£
=y System D
Options. x.x

=

@

S
Help

Verson

Context Sensitive menu (tuyi
ienaaviiiani)

Context Sensitive Menu (Luumnﬂwao
Autiiann) gaLflavineu auaENaY
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a1 Enable Context Menu (iflavingnu
wyLiian) gavintazavuanalunuiaig
Optlons>Preferences (ﬁuaan>msmnum
Anmay) aaazuadiulyil

g SmartControl
Select Preset 4
Tune Display

wiiland 4 sanns:
+ SmartControl Lite — lawdan About
Screen (tAgnAuMINRA) Azuanadiu

» Select Preset (Laanwwﬁm) My
dluandudurasnwiidaituiinly dvsu
L2 uui msawmnuammwwﬁm
Aidanluaaiiu uananil aauanunsa
3un Factory Preset (ws@miswwu) 10
ANUYIIEANTTENAIE

+ Tune Display (U5uaausnina) — tda
wHAILANUAY SmartControl Lite

+ SmartImage Lite - ATIAFAUMATHIAN
aqiiu iy Standard (an@su),
Internet (Auwnasiiin), Game (1Ax)

wyaavuidavineiu

AEINsTaLEAdNYAIANUlaTAENTAAN
anuulamau SmartControl Lite annana
U Msadnangasidawadwiindiy

Help

Technical Support
Check for Update
About

Exik

aavudl 5 51ans: .

+ Help (381%) — wundivludelwa User
Manual (qiiagla): alna User
Manual (afiagly) Taalznuianioius
LA UAU



» Technical Supportv(msaﬁuauusim
walla) — wEAYRUINTRTUAUUAIY
watia

+  Check for Update (asragaumidwian)
- uwhi"l,ﬂﬂoum PDI uasasrasday
nasifumaowhj WauAunasiudvuae
a7

«  About (1Aizafu) — usAYLaYRANEY
aEvazAna: DASTUNANAUN, VAYR
U Laziandnfaun

« Exit (aan) — da@ SmartControl Lite

un1s¥u SmartControl Lite 8na%s 11
L&an SmartControl Lite Ny Program
(sunsu) wiaduiiandniilanau PC uu
wannal wiaduszuulny

PHILIPS

SmartControl

‘SmartControl
\ersion 3.20
dhane-standard-R2007-01-04-1151-23
Copyright 1993-2007 Pertrad Displaye, Inc.
Paterts Pending

wyaavuiarineiu

Wiaanasugniavinoulutvainas ns
fuaaneay lawizsanTs EXIT (aan)
fsgusaly'le vWaau SmartControl

Lite aananaiasvuvasvauysal nda
¥i197u Run at Startup (Futflazueu) Tu
Options>Preferences (fatdan>n1sA1nua
ANWUL)

6 uueLG

mwﬂsynaumumiumuu 1‘1151'11&‘5‘1.|
Asavdaniiy nasfuzsanaws .
SmartControl aratldauuiaslatasly
aavualiniy Tusaaagauiu'lae
WasmsaaeLiun19nIs?i www. portrait.

om[dtune[phl[enu[mde Lwamau‘iuam

afaW@us SmartControl nasﬁ’umamaua
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www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index

4. ayaINNITAIUNAUA

AUAADIIANN IPS-ADS LCD
wualan LED
AUIAKRUIRA 27W (68.6 afu.)
AATIFIUNW 16:9
AUANNLUAR] 0.311 x 0.311 uw.
AU 300cd/m?2
SmartContrast 20,000,000:1
ansnAaunsdn (13ld) | 1000:1
nanauauad (1711) 14ms
SmartResponse 5ms(GtG)
ANUALLAANANFA 1920 x 1080 @ 60Hz
UNATTFUAN 178° (H) / 178° (V) @ C/R > 10
NSLANAATNURINTN SmartImage Lite
gNuaav'le 16.7 M
2605713 AUUIA 56Hz - 75Hz
ANNALUIUAY 30kHz - 83kHz
MHL 1080P @ 30Hz (277E6ESD/277E6ESW)
SRGB b1
SoftBlue ; U
ANMNUAINITAAUNSIAANAD
277E6ESD/277E6ESW: VGA (aundan), DVI (#3aaa,HDCP)
dunadeuana 277E6EDAW/277E6EDAD:
VGA (aun&an), DVI (A3naa,HDCP), MHL-HDMI(#3naa,HDCP)
. 277E6EDAW/277E6EDAD: 1&ev PC 120, yWeaan, taranatdes
L&evtan/aan HDMI
Fuanadune foawen, FIAuuFizer
277E6ESD/277E6ESW
. . - Ep/« /v /A /0K 0]
SRR 277E6EDAW/277E6EDAD:

/<4 /v (/A /0K [0)
aanm:r masnu qly, n3n, WS9LAd, 8an], d9n3,
LULEATUAUR, Tﬂsmna Tﬂsmna UNGR, ‘I:Ju,aum Sauie,
ey, ﬂuu@pﬂ m;sﬁ viin, auasy, ﬁuuwuﬁu‘mcy
uleniy, gy, tnnd
ANMNIALAINFUNEIAUY daa Kensington
AnuFnsaaunan & twaa | DDC/CI, sSRGB, Windows 8/7/XP, Mac OSX, Linux
2619
18819 -5° / +20°

a1 OSD

18



N
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m
o
m

Wi
. 277E6ESW/277E6ESD: 24.69 W(v3'll), 25.19 W(gesin)
Tuuatdaia3iag 277E6EDAW/277E6EDAD: 28.20 W(¥1'14), 31.48
W(guda)
a&ul (v3') 0.5W
o (v'1al) 0.3W

1WudavdaIug LED twiias

Tnadaiadad: 213, Tuuaawauaune/a81: 17 (negwsu)

unagng'lu

aauan, 100-240VAC, 50-60Hz

PN
HARSUNNIANANGY

NARATTNTANTIAY 640 x 478 x 235 .
(nx&xa)

waaAunlaluldgung 640 x 394 x 48 3.
(AXSXA)

5.42 nn.

wanfundialulagueng

5.17 an.

waulanisvineiu
292 und (uuevingu)

0°C v 40°C

aaaunnll (vayluvineu)

-20°C &y 60°C

ANUAANAAAILATUINTFIU

nsawihuassudfiauua
19AUAT9

ANuTuduing 20% &9 80%

MTBF 50,000 2.

ROHS ]

EPEAT sEaUu (Www.epeat.net)
UFTAAUMN Flafale 100%

FRABYRE MLA3avnilsnedann PVC BFR 100%
Energy Star bl

277E6EDAW/277E6EDAD: ta3avuune CE, FCC
aaa B,CU-EAC,SEMKO,1ususas TCO,ETL,1S09241-
307,SASO,KUCAS,EPA, VCCI aa1& B, C-TICK aa1& B

fltA3av
& wuALAas/&un
WUR? fu

6 uueLU6

—

EPEAT wisaeunasvidawisaandu alawmwnzdia Philips asnsifiaundadon Tusaidauuui

www.epeat.net &nFugarugnisasnsidaululdssinduasna

N

gayafiaraldsuwlasialaalunasuaslunsiu Wi www.philips.com/support tiia

AMNUTMAALKUAAYALATTUANEA

nanausuaddazasiiua

w

P

nengaannnsnesay GtG wia GtG (BW)


www.epeat.net
www.epeat.net
www.philips.com/support

41 anuazidan & TuNaNILda

b anuandaagedn
1920 x 1080 @ 60 Hz (Auwmaun&an)
1920 x 1080 @ 60Hz (Aunwmaudan)
B anuazdaaiiuuziii
1920 x 1080 @ 60Hz (Auwmaulfan)

ANuAuu ANu ANuAuL

uau (kHz) avidun 69 (Hz)
31.47 720x400 70.09
31.47 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.81
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00

48.36 1024x768 60.00

60.02 1024x768 75.03

63.89 1280x1024 60.02

79.98 1280x1024 75.03

55.94 1440x900 59.89

70.64 1440x900 74.98

65.29 1680x1050 59.95

67.50 1920x1080 60.00

& uunuLun
TWsansuaaudasrazasnaviuled
naanaNuasdaauasgIu 1920 x 1080
@ 60Hz alwlaaanInASUEAINATIA
n&n Tusavieuauuzinlunisaeaiau
azidaail

20



5. ANTARAITNAIIIU

mﬂmumsmuamwausaqjawmmm
fanAaaddyu VESA DPM mmﬁoau‘l,u PC
UAIAL aamwauammsﬁutﬂaaawaamu
ToudaTwid luaaeiilalalzdou mm‘m
wnmsﬂaumauaa’muﬂuwuw Lma wia
aﬂnimﬂaumamauq anAway "dudu”
Taadn Tulid m'swma"l,ﬂul,tamn'ﬁautﬂaaa
WAYIU Ltaunwsaoﬁmm1vmmammauumms
Usendanavouan Tulicil:

277E6ESW/277EGESD:
ANUNULADINTIANTWAIIIY
e | 4va
\T/“E’S‘: 3612 | ww | uwd | wdeowiily | &LED
uau o8]
24,60 W
; ‘ ()
uwaniiv fin o T 25.19 W fam
(F98m)
: . : g2
BRI 2] u T [ 0.5W (') o)
fawatas | éu - - | 0.3 W (vhl) &
277EG6EDAW/277E6EDAD:
ANANRUILYDINTIANITWAIIIY
doa | dGoa
\T/?SJ?\ 38Ta | ww | uwd | wdeowilla | &LED
uau o]
28,20 W
) _ ; ‘ (vl)
uwaniin A Taf Taf 31.48 W g1
(F98m)
sl | | | B | oswb) | ni’;‘;’u)
fawadas | Gu - - | 03w (vhll) i

msaemnaldfignlniainnisdunldas
w9 uuuanwil

o ANuaztduauInsgIu: 1920x1080
- paunEn: 50%

« anuae: 300 nits;

- anuunfd: 6500k wsangluuudnd
quysol

€ uuuun
dayaiiaratdasundadiataaluaanasinv

21
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6. AdYALALNAUSLILIU
A2LIALU
Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is designed for both you and the
planet!

sustainable [T - manufacture,

use and recycling of IT products
reflecting environmental, social and economic
responsibility.

. TCO Development works for
1]

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for ICT products worldwide.

Some of the Usability features of TCO
Certified Displays:

*  Visual Ergonomics for image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are Resolution,
Luminance, Contrast, Reflection and Colour
characteristics

*  Products are tested according to rigorous
safety standards at impartial laboratories

* Electric and magnetic fields emissions as
low as normal household background levels

*  Workload ergonomics to ensure a good
physical environment

Some of the Environmental features of TCO
Certified Displays:

*  Production facilities have an Environmental
Management System (EMAS or ISO 14001)

* Low energy consumption to minimize
climate impact

* Restrictions on Chlorinated and
Brominated flame retardants, plasticizers,
plastics and heavy metals such as cadmium,
mercury and lead (RoHS compliance)

* Both product and product packaging is
prepared for recycling

* The brand owner offers take-back options

Corporate Social Responsibility

* The brand owner demonstrates the
product is manufactured under working
practices that promote good labour
relations and working conditions.

The Criteria Document can be downloaded
from our web site. The criteria included in

this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all

over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of [T equipment in a more user
and environmentally friendly direction. Our ICT
product labeling system began in 1992 and is
now requested by users and |CT-manufacturers
all over the world.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit:
www.tcodevelopment.com

I[n Technology for you and the planet

CERTIFIED

(Only for selective models)

User mode is used for TCO Certified
compliance.


www.tcodevelopment.com

EPEAT

(Wwww.epeat.net)

(%  The EPEAT (Electronic
QQ Product Environmental
7 Assessment Tool) program
evaluates computer

desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006+A11:2009+A1:2010+A
12:2011+A2:2013 (Safety requirement of
Information Technology Equipment).

*  EN55022:2010(Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

* EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

»  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker).

* EN50581:2012 (Technical documentation
for the assessment of electrical and
electronic products with respect to the
restriction of hazardous substances)

*  EN 50564:2011 (Electrical and electronic
household and office equipment —
Measurement of low power consumption)

following provisions of directives applicable

*  2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

e 2009/125/EC (ErP Energy-related Product
Directive, EC No. 1275/2008 and 642/2009
Implementing)

* 2011/65/EU (RoHS Directive) and is
produced by a manufacturing organization
on 1SO9000 level.

And is produced by a manufacturing

organization on 1SO9000 level.

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.


www.epeat.net

Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR”
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont congues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences


www.energystar.gov

nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji

Urzdeenic powinne byt zasitane # poiazds 2 preylaczanyem obwodem ochronnye (gniazdo
Kalkiem ). Wapdlgracuface i sohq urzadzenia (kompuser, monitor, druksrkal powinny by sasilane
2 tegn samego drbdla.

Instalacja elekerycena pomiesscrenia powinn mwie
praneel swarciami, w pestaci berpiecanika o warto:
W el catkowitego wybserenia urzadzenia 2 siect zasilania, nalezy wyjné wivczkg kabla
easilajacega = poazdka, kidre powinno ssidowad s w pobliz urmJJanm:I!\t Batwi dosiepne.
Zaak bezpiecsefstwa "B” potwiendss podnosé uresdseia 2 wynaganiami bezpiecsehstva
whytkowania sawartyini w PN-ULTA2107 § PR-BOE-G

w przeworksie fzowym rezecrowa achrang
marmienavwe] e wicksej ni 164 (amperiuw).

Pozostale instrukcje bezpieczensiwa

* Niemaledy urywad wiyceek sdapterowych lub usuwaé kolka abwedu ackrornego 2 wiyeeki.
Jekeli Lu\m‘WIILJLJ LRy |:|1:\:\Jlural‘ra o naledy whyd preediuzace 3-pylowego 2
System kmpalerowy rnlny sabezpivcryt prred nagtymi, chwilow
ac eliminatora preepied, urradrenia dopasow
berzakidceniowe irinia zasilania.

warostami lub spad-
X

¢ nie lezalo na kablach systemu kompuieroweo, araz aby kable nic
adzse miodng byboby na i nadeptywad lub porykad sl o nie.

T e p——

Nie maleiy wpychad adnych preedmiotion do atwost sy
podar lub porpenie pridem, poprzez o

najdowad sig 2 dala od g

Tacyjnych. Nakezy un

karmpuler oriz umisszezanss kamputera w ciasmym migse bez mailiwobe eyrkalac peoi-

plerwy i

etz wokdl niego.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

S@RG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA,

BSMI Notice (Taiwan Only)
RBAZEARERZIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erfillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird
empfohlen, die Grundfarben Blau und
Rot nicht auf dunklem Untergrund zu
verwenden (schlechte Lesbarkeit und
erhdhte Augenbelastung bei zu geringem
Zeichenkontrast waéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

(D ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label

PHILIPS  conuoona
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The European Energy Label informs you on

the energy efficiency class of this product.

The greener the energy efficiency class of this
product is the lower the energy it consumes. On
the label, you can find the energy efficiency class,
the average power consumption of this product
in use and the average energy consumption for
1 year

&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.
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Information for U.K. only

WARNING - THIS APPLIANCE MUST BE
EARTHED.

Important:

This apparatus is supplied with an approved
moulded 13A plug. To change a fuse in this type
of plug proceed as follows:

1. Remove fuse cover and fuse.

2. Fit new fuse which should be a BS 1362
5AAS.TA. or BSI approved type.

3. Retit the fuse cover.

If the fitted plug is not suitable for your socket
outlets, it should be cut off and an appropriate
3-pin plug fitted in its place.

should it be inserted into a 13A socket

- fEPER If the mains plug contains a fuse, this should
Pb | Hg | Cd | Cr6+ | PBBs | PBDEs have a value of 5A.If a plug without a fuse is
i O | o] o]0 ]0o 0 used, the fuse at the distribution board should
Wi A28 — (0] 0]
7 o 191910 not be greater than 5A.
ARVER 6] [0] (0] 6] (0] 0]
WLED %ﬁ@% o o o | o o NOTE: The seyered plgg must be destroyed
LCD /S L e to avoid a possible shock hazard
TEAPR | HERIPR
CCFL s v (0] 6] (0] (0]
3 IRR elsewhere.
PCBA s [0] [0] 6] 0] o
_ s
=7V &I7A4Y o (0] 0] 6] (0] 0]
. s
PES= g e (0] (0] 6] (0] 0]

* D PCBA AT HIREIK SR, TSN, BAZMNT BIUESH, o
VTV TL—, ART R FuTRE TORMELETL AV THE
MENET,

i1 T0) 3, GRS NAWHEOSERPBREHEZHEZI TVEVNT L
ZRLET,

FE 20 DEMBRL) TEEIE, R OB JIS C 0950 DBIKIC & v
BRI & ENFHEICHIES 5 L RFE®RLE T,

JIS € 0950
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How to connect a plug

The wires in the mains lead are coloured in
accordance with the following code:

BLUE -“NEUTRAL'("“N")
BROWN -“LIVE"(“L")
GREEN&YELLOW -“EARTH"("E")

1. The GREEN&YELLOW wire must be
connected to the terminal in the plug
which is marked with the letter "E" or by
the Earth symbol or coloured GREEN or
GREEN&YELLOW.

2. The BLUE wire must be connected to the
terminal which is marked with the letter
"N" or coloured BLACK.

3. The BROWN wire must be connected
to the terminal which is marked with the
letter "L" or coloured RED.

Before replacing the plug cover, make certain

that the cord grip is clamped over the sheath of

the lead - not simply over the three wires.

29
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Aayadianadmisuginia glslaziuan:

szind CcSP vunmazdaalay  51a0 nalinnis

Austria RTS +43 0810 000206 €0.07 Mon to Fri: 9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri:9am - 6pm
Cyprus Alman +800 92 256 Free of charge [Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff |Mon to Fri: 9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri: 9am - 6pm
Germany RTS +49 01803 386 853  |€ 0.09 Mon to Fri:9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge |Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri:8am - 5pm
[taly Anovo [taly +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri: 9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri:9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri:9am - 6pm
Portugal Mainteq +800 780 902 Free of charge |Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €0.10 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri: 9am - 6pm
Switzerland ANOVO CH [+41 02 2310 2116 Local call tariff | Mon to Fri: 9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri:8am - 5pm

Aayadanadnisuniinia azduawdai:

szine

maatdulnas

uninaauA LA TNA

Brazil

Argentina

Vermont

0800-7254101

0800 3330 856

Aayadanadnisu fu:

szine

maatduinas

uvunaaanhaquarusinag

China

PCCW Limited

4008 800 008
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www.philips.com/support

Aayadinnadmisugiinia glsidnatvuazariuaan:

Aaa

iHuinas vunaaaniaguaguding
+375 17 217 3386
Belarus N/A IBA +375 17 217 3389
Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport +420 272 188 300
+372 6519900 (General)
Estonia N/A FUJITSU +372 6519972 (workshop)
Georgia N/A Esabi +995 322 91 34 71
+36 1 814 8080 (General)
Hungary N/A Profi Service +36 1814 8565 (For AOC&Philips only)
Kazakhstan N/A Classic Service Ll.c. | +7 727 3097515
+371 67460399
Latvia N/A ServiceNet LV +371 27260399
+370 37 400160 (general)
Lithuania N/A UAB Servicenet +370 7400088 (for Philips)
Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and +386 1 530 08 24
the republic of Belarus | N/A ServiceBy +375 17 284 0203
Turkey N/A Tecpro +90 212 444 4 832
Ukraine N/A Topaz +38044 525 64 95
Ukraine N/A Comel +380 5627444225
Jayadinnad1nisu awdnuila :
szina maatduinas vunaaanhaguarusinag
USA. EPl-e-center (877) 835-1838
Canada EPl-e-center (800) 479-6696
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Aayadinnadisuginia APMEA :

sz ASP  wunuwaadhuguanuding nains
Armenia
AT
Georgia . +97 14 8837911 Sun.~Thu. 09:00 - 18:00
service centre
Kyrgyzstan
Tajikistan
AGOS
Australia NETWORK  [1300 360 386 Mon.~Fri. 9:00am-5:30pm
PTY LTD
Company: Hong Kong:
Hong Kong | Smart Pixels | Tel: +852 2619 9639 Mon.~Fri. 9:00am-6:00pm
Macau Technology Macau: Sat. 9:00am-1:00pm
Ltd. Tel: (853)-0800-987
, REDINGTON | Tel: 1 800 425 6396 ,
India INDIALTD | SMS: PHILIPS to 56677 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086
Indonesi E—EFR(\:/EI;R\IIVEI;% (Customer Hotline) Mon.~Thu. 08:30-12:00; 13:00-17:30
onesa +62-8888-01-9086 Fri. 08:30-11:30; 13:00-17:30
PERKASA .
(Customer Hotline)
Israel E%m”'cs 1-800-567000 Sun.~Thu. 08:00-18:00
Alphascan Mon.~Fri. 9:00am-5:30pm
Korea Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. R-Logic Sdn Mon.~Fri. 8:15am-5:00pm
Malaysia 1 gng 603 5102 3336 Sat. 8:30am-12:30am
New Zealand \L/t'zua' Group | 5800 657447 Mon.~Fri. 8:30am-5:30pm
Pakistan TV.O’\”CS +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Pakistan
EA Global
Philippines Supply Chain | (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.
Philips
Singapore Pte .
. o Mon.~Fri. 9:00am-6:00pm
Singapore Ltd (Philips (65) 6882 3966 Sat. 9:00am-1:00pm
Consumer
Care Center)
Computer
South Africa | Repair 011 262 3586 Mon.~ Fri. 08:00am~05:00pm

Technologies
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Attention

Monitor control locked
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